Oklahoma Department of Transportation

Job Access and Reverse Commute (JARC) & New Freedom

Application Guide 2009
Oklahoma DOT JARC/New Freedom Application Guide 2009

This guide provides requirements and instructions for the 2009 Oklahoma Department of Transportation Section 5316 Jobs Access and Reverse Commute (JARC) and Section 5317 New Freedom grant funding application. Under the Safe, Accountable, Flexible, Efficient Transportation Equity Act: A Legacy for Users (SAFETEA-LU), to receive funding under the New Freedom and the Job Access and Reverse Commute (JARC) program, applicants must certify that approved projects are derived from a Coordinated Public Transit-Human Service Transportation Plan (Plan). A Plan for Oklahoma has been prepared and is available on the CD distributed at the training session.

As designated by the Governor of Oklahoma, ODOT is the applicant and recipient for Job Access and Reverse Commute and New Freedom funds and is responsible for implementing the selection process to determine projects that will be awarded funds. (For the purposes of this application, ODOT is the recipient of the Federal Transit Administration funds, and all applicants are potential subrecipients of Federal Transit Administration funds).

Please review the contents of this guide and have available when completing the Excel-based application.

Contents
Submission Requirements ........................................................................................................ 2
Excel Application Instructions ................................................................................................. 3
Job Access and Reverse Commute Program ........................................................................... 6
New Freedom Program ........................................................................................................... 6
Eligible Applicants for Job Access and Reverse Commute and New Freedom Funds .......... 7
Funds Available ....................................................................................................................... 7
Federal / Local Matching Requirements .................................................................................. 8
Application Timeline ............................................................................................................... 9
Proposal Submittal .................................................................................................................... 9
Evaluation Committee ............................................................................................................. 10
Grant Contract Award Requirements ..................................................................................... 10
Evaluation Criteria .................................................................................................................. 10
Coordination/Funding Mix Rating ........................................................................................... 11
Scope of the Project and Consistency with the Coordinated Plan ........................................ 12
Other Project Details .............................................................................................................. 13
Performance Plan (25 points) ................................................................................................ 14
Application Checklist .............................................................................................................. 16
Appendix - Certifications
Submission Requirements
This application is divided into three parts. To be considered for funding, applicant must print and submit a completed Excel application as well all relevant attachments. The applicant is encouraged to use the checklist provided at the end of this guide to ensure all necessary components of the application are submitted.

Part I: Excel Application
The first part of the application is the Excel form. Applicant must complete all seven (7) sections. More detailed information on the technical application is provided in Excel Application Instructions.

Part II: Attachments
Applicant must include the name of the project sponsor as well as the project title on all of the following attachments:
- Proof of Applicant Status: Applicant should submit documentation of applicant status selected in section 1 of the Excel application.
- Proof of Population or Project Area Size: Applicant should submit documentation that supports the target size or population of study area as per Section 3 of Excel application. Example documentation includes US Census Bureau data, County or municipal planning department data, and/or maps.
- Narrative description of proposed project and its target users.
- Description of project sponsor’s proposed management of the project and relevant qualifications. Applicant should note assigned staff and qualifications for the project.
- Scanned copy of last audit findings and, for new organizations, include a letter of certification to demonstrate financial capability.
- Relevant performance plan supporting documents:
  - New Projects: Performance Plan. A separate performance plan must be included for capital and operating projects.
  - Existing Project with Previous Performance Plan: Copy of previous performance plan and data to support performance of each measure defined in the previous plan.

Part III: Certifications
Applicant must print, complete with ink pen, and submit the following forms as part of the 2009 application:
- Short-Term Coordination Strategies Commitment Form
- FTA Certifications and Assurances for Federal Transit Administration Assistance Programs
- Matching Funds Commitment Form
(Note: Alternately, the application may be completed using the Typewriter Tool in Adobe Acrobat, printed, signed, and then submitted.)
Excel Application Instructions

The main 2009 application is a protected Microsoft Excel workbook. The applicant is guided through a series of userforms that populate the cells in the application. (See Figure A). Before opening the application the applicant must ensure that macros are enabled (see Enabling Macros at bottom of page).

When the applicant opens the application for the first time, he or she will be prompted to choose “Starting a New Application” or “Continuing an Existing Application.” If the applicant selects “Starting a New Application,” the userform for Section 1 of the application will open.

If continuing an existing application, the applicant can select which section to navigate to on the summary sheet of the application. From the summary sheet, the applicant can select the appropriate “Edit Section” button.

The following sections include information on enabling macros, navigating the application, and general application completion tips.

Enabling Macros

Every time the applicant opens the application, he or she must ensure that macros are enabled. The easiest way to do this is to lower Microsoft Excel macro security settings to “medium”. With this setting, Microsoft Excel will give the user the option of enabling macros whenever an Excel workbook is opened.
By default, Microsoft Excel sets the security option to “high” for Macros. The high setting prevents a virus possibly contained in an Excel macro from infecting a computer when a workbook sent from an untrusted source is opened. Changing Excel macros setting to medium will allow the applicant to choose when to enable macros on a case-by-case basis. Instructions on changing security setting for Excel 2003 and 2007 are provided below.

**Excel 2003**
1. From the Tools menu, select Macro, and then, in the submenu, select Security.
2. In the Security dialog box, click Medium.
3. Click OK.
4. The applicant may then open the Excel application. In the dialog box that appears, select Enable Macros.

**Excel 2007**
1. On the Developer tab, in the Code group, click Macro Security. *(Tip: If the Developer tab is not displayed, click the Microsoft Office Button, click Excel Options, and then in the Popular category, under Top options for working with Excel, click Show Developer tab in the Ribbon.)*
2. In the Macro Settings category, under Macro Settings, select medium. Click OK.
3. Open the Excel application. In the dialog box that appears, choose Enable Macros.

**Navigating the Application**
To edit a particular section of the Excel application, the applicant must select the appropriate “Edit Section” button for the seven sections of the application on the summary sheet (See Figure 2 below). Clicking on the edit section button will open the appropriate userform.

![Figure 2 Application Worksheet - Section Edits](image-url)
As the application worksheet is lengthy and can be difficult to scroll through manually, the button to the top right of the application, “Navigate to Section,” can be used to open a specific section of the application or to review previous responses. Clicking that button will open the menu to the right. After selecting the appropriate section and clicking continue, the Excel sheet will scroll to the heading and “Edit Section” button of the selected section.

**Printing the Application**  
To print the application for submission, the applicant must use “Print Completed Application” button located at the end of the application. Upon clicking that button, the Excel sheet will format the application for printing and open the print dialog box. **The applicant should not under any circumstances use File ➔ Print or the print shortcut icon in the standard toolbar to print. This will not format the application for print and it may not print correctly for submission.**

**General Tips for Completing the Application**

- Before opening the application for the first time, immediately drag the file to the appropriate location on hard drive.
- Try to complete application in sequential order. Some responses are linked to later sections of the application.
- The application userforms do not save information. Rather, each entry in the userform is linked to a cell in the worksheet application. Only the application summary sheet should be used to check answers. The userforms are only used to input information.
- A background save is performed when a “continue,” “return to summary sheet,” “next,” or “finish” button is clicked. Because of the amount of information stored in the worksheet in the form of macros, these background saves may take some time.
- Sometimes the application may not recognize the first entry typed into the form. In the event this occurs, please re-type the information.
- Do not enter dollar signs or commas when entering dollar amounts. Excel will format the entry.
- Always hit “enter” after inputting numerical or text changes. This is especially important in making edits to Section 4 (Project Budget), as many calculations are triggered through this key.
Job Access and Reverse Commute Program

The goal of the Job Access and Reverse Commute program is to develop new services and improve existing transportation services to connect welfare and low income\(^1\) individuals to work and needed employment support services such as childcare and job training activities, and to transport residents of urbanized areas and non-urbanized areas to suburban employment opportunities. With many new entry-level jobs located in suburban areas, low-income and/or welfare recipients have found it difficult to access these jobs from the inner city, urban and rural neighborhoods on a daily basis. Many entry-level jobs require working late at night or on weekends when conventional transit services in many communities are either reduced or non-existent and many employment-related trips are complex for low-income persons, often involving multiple destinations, including reaching childcare facilities and other services as part of the work trip.

**Eligible Activities for Job Access/Reverse Commute Grants:** Funds include capital, planning, and operating expenses to support activities, including, but not limited to late night and weekend service, guaranteed ride home service, facilitating the provision of public transportation services to suburban employment opportunities, supporting new mobility management and coordination programs among public transportation providers and human service providers, etc. For a complete and extensive list of eligible Job Access and Reverse Commute activities, see 5316 Federal Transit Administration Guidance Circular effective May 1, 2007.

ODOT is soliciting projects that have been derived from the adopted Plan. This Plan specifically focuses on the transportation needs of elderly, disabled, and low-income residents and addresses the service needs and gaps statewide.

New Freedom Program

The goal of the New Freedom Program is to support new public transportation services and public transportation alternatives to address the transportation needs of persons with disabilities\(^2\) including transportation to and from jobs and employment support services, beyond those required by the Americans with Disabilities Act (ADA) of 1990.

For the purpose of the New Freedom Program, “new” service is any service or activity that was not operational on August 10, 2005, and did not have an identified funding source as of August 10, 2005, as evidenced by inclusion in the Transportation Improvement Program (TIP) or the State Transportation Improvement Program (STIP).

**Eligible Activities for New Freedom Grant** Eligible projects funded with New Freedom funds may continue to be eligible for New Freedom funding indefinitely as long as the project(s) continue to be part of the coordinated plan. Both new public transportation services and new public transportation alternatives are required to go beyond the requirements of the Americans with Disabilities Act and must (1) be targeted toward individuals with disabilities; and (2) meet the intent of the program by removing barriers to transportation and assisting persons with disabilities with transportation, including transportation to and from jobs and employment services.

\(^1\) Eligible Low-income Individual: Refers to an individual whose family income is at or below 150 percent of the poverty line for a family of the size involved.

\(^2\) Eligible Person with a Disability: Refers to an individual who has a disability that limits one or more major life activities.
Recipients or subrecipients may not terminate Americans with Disabilities Act paratransit enhancements or other services funded as of August 10, 2005, in an effort to reintroduce the services as “new” and then receive New Freedom funds for those services.

Activities that could be funded under the program include, but are not limited to enhancing paratransit beyond minimum requirements of the ADA, new feeder services (transit service that provides access) to commuter rail, commuter bus, intercity rail, and intercity bus stations, new Public Transportation Alternatives beyond the Americans with Disabilities Act, etc. For a complete and extensive list of eligible New Freedom activities, see 5317 Federal Transit Administration Guidance Circular effective May 1, 2007.

ODOT is soliciting projects that have been derived from the adopted Plan. This plan specifically focuses on the transportation needs of elderly, disabled, and low-income residents and addresses the service needs and gaps statewide.

**Eligible Applicants for Job Access and Reverse Commute and New Freedom Funds**

There are three categories of eligible applicants for Job Access and Reverse Commute and New Freedom funds:

a. Private non-profit organizations defined as a corporation or association determined by the Secretary of the Treasury to be an organization described by 26 U.S.C. 501 (c) which is exempt from taxation under 26 U.S.C. 501 (a) or one which has been determined under State law to be non-profit and for which the designated State agency has received documentation certifying the status of the non-profit organization.

b. State or local governmental authority, including tribal governments; and

c. Operators of public transportation services, including private operators of public transportation services.

**Funds Available**

FTA apportionments to ODOT for 2009 form the basis of funding for the current grant process. Funds available for the current grant process are as follows:

**JARC Funds**

<table>
<thead>
<tr>
<th>Apportionment</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small Urban (Norman and Lawton)</td>
<td>$381,067</td>
</tr>
<tr>
<td>Rural (&lt;50,000 population)</td>
<td>$847,284</td>
</tr>
</tbody>
</table>

**New Freedom Funds**

<table>
<thead>
<tr>
<th>Apportionment</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small Urban (Norman and Lawton)</td>
<td>$157,287</td>
</tr>
<tr>
<td>Rural (&lt;50,000 population)</td>
<td>$532,027</td>
</tr>
</tbody>
</table>
Federal / Local Matching Requirements

Jobs Access Reverse Commute funds may be used to finance capital, planning and operating expenses. New Freedom funds may be used to finance capital and operating expenses. The Federal share of eligible capital and planning costs may not exceed 80 percent of the net cost of the activity. Operating costs may not exceed 50 percent of the net operating costs of the activity.

The local share of eligible capital and planning costs shall be no less than 20 percent of the net cost of the activity, and the local share for eligible operating costs shall be no less than 50 percent of the net operating costs. All of the local share must be provided from sources other than Federal Department of Transportation funds.

<table>
<thead>
<tr>
<th>JARC Funds Matching Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type of Funding</strong></td>
</tr>
<tr>
<td>Capital (incl. planning &amp; marketing)</td>
</tr>
<tr>
<td>Operating</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>New Freedom Funds Matching Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type of Funding</strong></td>
</tr>
<tr>
<td>Capital (incl. marketing)</td>
</tr>
<tr>
<td>Operating</td>
</tr>
</tbody>
</table>

Some examples of sources of local match which may be used for any or all of the local share include: State or local appropriations; other non-Department of Transportation Federal funds; dedicated tax revenues; private donations; toll revenue credits; and net income generated from advertising and concessions. Non-cash share such as donations, volunteered services, or in-kind contributions is eligible to be counted toward the local match as long as the value of each documented and supported, represents a cost which would otherwise be eligible under the program, and is included in the net project costs in the project budget.

Income from contracts to provide human service transportation may be used to reduce the net project cost (treated as revenue). In this case, the cost of providing the contract service is included in the total project cost. No Federal Transit Administration program funds can be used as a source of local match for other Federal Transit Administration programs, even when used to contract for service. Fares or payments for service cannot be included in the local match.

Exceptions: The federal share is 90 percent for vehicle-related equipment and facilities required by the Clean Air Act (CAA) or the Americans with Disabilities Act (ADA). It is only the incremental cost of the equipment or facility required by the Clean Air Act or Americans with Disabilities Act that may be funded at 90 percent, not the entire cost of the vehicle or facility, even if the vehicle or facility is purchased for use in service required by the Americans with Disabilities Act or Clean Air Act. Organizations wishing to apply for assistance at the higher match ratio should consult the Federal Transit Administration regional office for further guidance regarding methods for computing the incremental cost before submitting an application.
Use of Other Federal Funds: Local match may be derived from other Federal funds derived from Federal programs that are eligible to be expended for transportation, other than from the Department of Transportation programs. Examples of types of programs that are potential sources of local match include: employment training, aging, community services, vocational rehabilitation services and Temporary Assistance for Needy Families (TANF). To be eligible for local match for Federal Transit Administration funds, the other Federal funds must be used for activities included in the total net project costs of the Federal Transit Administration grant. Expenditure of other Federal funds for transportation outside the scope of the project cannot be applied as a credit for local match in the Federal Transit Administration grant. Specific program information for other types of Federal funding is available at www.unitedweride.gov.

Application Timeline

<table>
<thead>
<tr>
<th>Activity</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notice of Grant Availability and Workshop Announcement</td>
<td>February 11, 2009</td>
</tr>
<tr>
<td>Application Workshops</td>
<td>March 10-12, 2009</td>
</tr>
<tr>
<td>Application deadline</td>
<td>May 1, 2009</td>
</tr>
<tr>
<td>Application review and ratings</td>
<td>May 2009</td>
</tr>
<tr>
<td>Notification of selected applicants</td>
<td>June 2009</td>
</tr>
</tbody>
</table>

Proposal Submittal

Applications must be hand delivered or mailed to ODOT’s office at:

Oklahoma Department of Transportation
Transit Programs Division
Attn: Application for JARC and New Freedom Grant Program
200 N.E. 21st Street
Room 3D4
Oklahoma City, OK 73105

Applications must be received in the office no later than 4:00 PM on May 1, 2009. Applications received after this time will not be considered for funding. ODOT staff will certify the date / time it was received. Original signatures are required where appropriate. In providing paper copies, one original and 11 copies are required for the submittal.

All copies of the application are to be packaged in one envelope or box that is clearly labeled “Application for JARC and New Freedom Grant Program.”
Evaluation Committee
As the designated recipient, ODOT will coordinate the competitive selection process. A grant evaluation committee has been developed with representatives from the following agencies:

- Tribal Transportation Advisory Board;
- Oklahoman Department of Commerce;
- Oklahoma Department of Rehabilitation Services;
- Oklahoma Department of Human Services;
- Oklahoma Office of Disability Concerns;
- Oklahoma Health Care Authority;
- Oklahoma Developmental Disabilities Council;
- Oklahoma Transit Association; and
- Oklahoma Department of Transportation.

Projects will be ranked based on criteria described in Evaluation Criteria. If there are insufficient funds for all eligible projects, contracts will be awarded based on the ranking of the projects. Projects may not necessarily be fully funded up to the dollar amount requested on the application.

Grant Contract Award Requirements
All approved Job Access and Reverse Commute and New Freedom applicants will enter in a contract with ODOT and will abide by all applicable federal requirements including background certifications, assurances, and other documentation necessary to meet the requirements of the Federal Transit Administration.


ODOT, as the designated recipient, is required to submit status reports to the Federal Transit Administration. This data collection process will consist of regular reports required from grant subrecipients that include program narrative information describing services, coordination efforts, sustainability, accomplishments, and obstacles or barriers. This is in addition to service statistics such as maps of geographic boundaries, ridership counts, number of employment sites served, etc.

Evaluation Criteria
Applications will be reviewed by the Statewide Evaluation Committee (The Committee) to ensure compliance with the minimum requirements in order to be considered for funding, including the submission of all mandatory forms.

Applications must show the following:

1. All agencies and/or project sponsors must show the financial, technical and organizational capacity to complete the project within a reasonable timeframe.
2. Project budgets must meet FTA guidelines for the Section 5316 and Section 5317 programs.
3. Project sponsor cannot have any projects within the last five years that have been terminated for cause or due to a shortfall of matching funds.
4. Project sponsor must have attended a mandatory JARC and New Freedom Grant Workshop.
5. The project or program cannot be located in an urban transportation management area.

The goal of the process will be to award funds to projects that achieve the desired benefits toward the transportation of the target populations. The Committee reserves the right to ask a project sponsor for supplemental information about a proposed project. The Committee may also deny funds to any project that does not meet the criteria established. At the conclusion of the evaluation process, any unobligated funds shall be rolled into the next year’s funding cycle.

ODOT will host a series of training workshops in conjunction with its call for projects. The Committee will review only those projects that are submitted by sponsoring organizations that have attended a mandatory training workshop.

**Coordination/Funding Mix Rating**

Proposed projects will be evaluated based on their ability to coordinate with other community transportation and/or social service resources. The project sponsor may choose how it would like this aspect of the proposal to be evaluated. Only one of the options below can be selected.

1. **Rating Option 1** - Up to twenty (20) points will be awarded for their project’s methods for coordinating their services and promoting public awareness of the project. The project sponsor must provide a narrative that describes their efforts to coordinate with other agencies and how their project will enhance or augment the transportation service in a defined area. The number of points will be awarded at the discretion of the Committee.

2. **Rating Option 2** – Two (2) points will be awarded for every entity that is providing matching funds, regardless of source. However, any participating entity must be governed or managed independently from the project sponsor. One (1) additional point will be awarded to the project for each agency whose clients are served by the project, may purchase the service provided by the project or facilitate a connection to other transportation-related services.

While the Rating Option 1 is capped at 20 points, if the project sponsor chooses Rating Option 2, up to 25 points are available.

Capital projects may utilize FTA funds for up 80% of the project cost, while operating expenses are capped at 50% of the project cost. Mobility management programs are also eligible for 80/20 matching. Project sponsors must identify the source and amount of matching funds for their project. The following schedule outlines the points awarded for those projects that can provide an overmatch to the FTA funds. Project sponsors should identify the funding category for which their project best qualifies. Project sponsors are reminded that FTA matching requirements stipulate that the percentage match is based on net operating cost (fares cannot be included in the matching funds).
If 2.5% or more of matching funds are derived from local sources such as private sector funds, municipal or county governments or local foundations, the project will receive an extra 5 points. In-kind contributions will be awarded 2 points.

If the project is eligible for two or more of the following FTA funding categories: urban, small urban (Section 5307) and rural (Section 5311) funds; or Section 5310, Section 5316 and Section 5317, it will be awarded two (2) bonus points. Eligible activities are shown in their respective circulars at www.fta.dot.gov or in the funding section of the Coordinated Plan.

Scope of the Project and Consistency with the Coordinated Plan

Project’s Target Population
The project point values can be increased by showing that the project accomplishes one or more of the following:
- Add 1 point if the project addresses two of the targeted populations (elderly, disabled and/or low income);
- Add 5 points if the project addresses all three of the targeted populations;
- Add points if the project encompasses the following portions of the State (area based or population based).

<table>
<thead>
<tr>
<th>1-3%</th>
<th>3-6%</th>
<th>6-10%</th>
<th>10-20%</th>
<th>20-35%</th>
<th>35-50%</th>
<th>51-75%</th>
<th>75%+</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>4</td>
<td>6</td>
<td>9</td>
<td>12</td>
<td>16</td>
<td>20</td>
</tr>
</tbody>
</table>

Project’s Gaps & Issues
Each of the gaps and issues identified has been given a corresponding point value based on the emphasis placed on it during the Coordinated Plan development process. That corresponding value will be increased based on how many of the target populations are served and how far reaching the project services are.

Gaps and Issues and corresponding point values are highlighted in the chart on the following page.
<table>
<thead>
<tr>
<th>Gap/Issue</th>
<th>Point Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Access to Jobs</strong></td>
<td></td>
</tr>
<tr>
<td>Impacts of Reduction in JARC Funding</td>
<td>5</td>
</tr>
<tr>
<td>2nd and/or 3rd Shift Jobs</td>
<td>2</td>
</tr>
<tr>
<td><strong>Marketing of Services</strong></td>
<td></td>
</tr>
<tr>
<td>Public Information Program/Mobility Manager</td>
<td>5</td>
</tr>
<tr>
<td>Reduce time required for reservations</td>
<td>1</td>
</tr>
<tr>
<td><strong>Need for More Service</strong></td>
<td></td>
</tr>
<tr>
<td>Connecting Communities/Town Transportation</td>
<td>5</td>
</tr>
<tr>
<td>Increasing the Utilization of Existing Service</td>
<td>4</td>
</tr>
<tr>
<td>Evening and weekend transportation for all purposes</td>
<td>2</td>
</tr>
<tr>
<td>Broaden Eligibility Requirements</td>
<td>2</td>
</tr>
<tr>
<td>(Lack of medical transportation for those who do not qualify for Sooner Ride above threshold for Medicaid but still low/fixed income)</td>
<td></td>
</tr>
<tr>
<td>Transit needs to be more affordable to the user</td>
<td>1</td>
</tr>
<tr>
<td><strong>Improve the Efficiency of Service</strong></td>
<td></td>
</tr>
<tr>
<td>Improving the Connectivity of Services</td>
<td>3</td>
</tr>
<tr>
<td>Addressing the Rising Cost of Providing Service</td>
<td>1</td>
</tr>
<tr>
<td>Long wait times for return trips from out-of-town destinations</td>
<td>1</td>
</tr>
<tr>
<td>Driver Retention (More of an issue in the West)</td>
<td>1</td>
</tr>
<tr>
<td><strong>Capital Improvements</strong></td>
<td></td>
</tr>
<tr>
<td>Lack of appropriate passenger waiting areas - ADA Accessibility</td>
<td>2</td>
</tr>
<tr>
<td>Lack of sufficient number of transit vehicles to accommodate demand / ADA accessible</td>
<td>2</td>
</tr>
<tr>
<td><strong>Other Project Details</strong></td>
<td></td>
</tr>
<tr>
<td>Is the sponsor requesting one year of funding (Yes = 10 points)?</td>
<td></td>
</tr>
<tr>
<td>Is the sponsor requesting two years of funding?</td>
<td></td>
</tr>
<tr>
<td>▪ Operating Project with future funding not identified (Yes = 0).</td>
<td></td>
</tr>
<tr>
<td>▪ Operating Project with future funding identified (Yes = 10 points).</td>
<td></td>
</tr>
<tr>
<td>Is the project taking advantage of or using new technology? (Yes = 3 points)</td>
<td></td>
</tr>
<tr>
<td>Does the project reduce its dependence on federal funding over time? (Yes = 8 Points)</td>
<td></td>
</tr>
<tr>
<td>In an effort to offer the Committee some flexibility, the project sponsor will be awarded an additional 3 points if partial funding options for the project are identified by either reducing the scale or altering the schedule of the project.</td>
<td></td>
</tr>
</tbody>
</table>
Performance Plan (25 points)
NEW PROJECTS ONLY

Applicants must submit three (3) clearly-defined measurable outcome-based performance measures to track the effectiveness of the project in meeting the identified goals and impact on transportation-disadvantaged residents. A proposed plan of action should be provided for ongoing monitoring and evaluation of the service. The points will be based on the review of the Committee and awarded to the project if deemed acceptable. If the performance measures are determined not to be acceptable, then the project will forfeit the points and if selected for funding, will be subject to evaluation criteria established by the Committee. More information about how to establish performance measures for a project is included in the Coordinated Plan and will be available at the mandatory training workshops.

Capital Projects must have a milestone-based performance plan. The sponsor should provide dates for implementation and minimum utilization thresholds. (NOTE: Vehicles purchased with Section 5310 funds must meet a minimum utilization standard set by the Oklahoma Department of Human Services.)

Operating Projects must set a productivity (riders/week, riders/mile, etc) threshold based on regional and/or national statistical information and its scope of service. Phased goals will be acceptable in order to take into consideration the time it may take for operating projects to reach their intended level of productivity.

EXISTING PROJECTS - without Previous Performance Plan Only
Service Effectiveness
Service Consumed/Units Produced (i.e., passenger trips/hour of service)

<table>
<thead>
<tr>
<th>Above Range of Industry Standard</th>
<th>8 points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Within Range of Industry Standard</td>
<td>4 points</td>
</tr>
<tr>
<td>Below Industry Standard</td>
<td>0 points</td>
</tr>
</tbody>
</table>

Cost Efficiency
Cost/Units Produced (i.e., cost/hour)

<table>
<thead>
<tr>
<th>Above Range of Industry Standard</th>
<th>8 points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Within Range of Industry Standard</td>
<td>4 points</td>
</tr>
<tr>
<td>Below Industry Standard</td>
<td>0 points</td>
</tr>
</tbody>
</table>

Cost Effectiveness
Cost/Service Consumed (i.e., cost/passenger trip)

<table>
<thead>
<tr>
<th>Above Range of Industry Standard</th>
<th>8 points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Within Range of Industry Standard</td>
<td>4 points</td>
</tr>
<tr>
<td>Below Industry Standard</td>
<td>0 points</td>
</tr>
</tbody>
</table>
EXISTING PROJECTS - with Performance Plan Only

Applicants must submit an assessment as to how their project met their program's defined performance plan over the past year. An existing project will be awarded points based on the number of performance measures in which their project exceeded or met predicted thresholds. Note: That all performance plans must have three (3) measures. Projects are categorized dependent on the number of performance measures they met or exceeded during the previous year as shown in the table below.

<table>
<thead>
<tr>
<th>Performance Criteria</th>
<th>Category 1</th>
<th>Category 2</th>
<th>Category 3</th>
<th>Category 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Points</td>
<td>0</td>
<td>10</td>
<td>20</td>
<td>30</td>
</tr>
</tbody>
</table>

Only those projects in Category 3 will be awarded an additional 7 points if they can show that a corrective action has been implemented and that the program is meeting its third performance measure over the past quarter. Or, an additional 4 points will be awarded if they can identify a reasonable cause for the program not meeting its third performance measure and define a corrective action for subsequent years.

Only those projects in Category 1 and 2 will be awarded an additional 5 points if they can identify a reasonable cause for the program not meeting its second and third performance measures and define a corrective action for subsequent years.

Maximum scores under this criterion are as follows:

- **Category 4** – Means the project met all of its performance criteria during the previous year. The project scores the maximum available points (30).
- **Category 3** – Means the project met 2 out of 3 of its performance criteria during the previous year. The project scores 20 points for attaining two performance measures and then can garner 4 or 7 more points based on a corrective action that is either in effect or will be in place. The number of points available for this category is 20, 24 or 27 points.
- **Category 2** – Means the project met 1 out of 3 of its performance criteria during the previous year. The project scores 10 points for attaining one performance measure and then can garner 5 more points based on a corrective action that is either in effect or will be in place. The number of points available for this category is either 10 or 15 points.
- **Category 1** – Means the project met 0 out of 3 of its performance criteria during the previous year. The project does not score any points for attaining performance measures and then can garner 5 more points based on a corrective action that is either in effect or will be in place. The number of points available for this category is either 0 or 5 points.
Application Checklist

Please use the checklist below to ensure that you have completed all sections of the application. For more information on these items, please refer to Submission Requirements on page 2 of this Application Guide.

All additional attachments must have the project title and project sponsor on every page.

- Completed Excel Application
- Documentation of Applicant Status
- Proof of Population or Project Area Size
- Narrative Description of Proposed Project, Target Users, and Goals
- Description of Agency’s Proposed Management of Project and Relative Qualifications
- Scanned copy of last audit findings and, for new organizations, include a letter of certification to demonstrate financial capability.
- Relevant Performance Plan Attachments
- Completed Short-Term Coordination Strategies Commitment Form
- Completed FTA Certifications and Assurances for Federal Transit Administration Assistance Programs
- Completed Matching Funds Commitment Form
Federal regulations require that agencies improve human services transportation by coordinating with each other. The following short-term strategies are part of the Coordinated Public Transit - Human Services Transportation Plan for the State of Oklahoma which was developed in compliance with new SAFETEA-LU regulations. All agencies applying for 5316 Job Access and Reverse Commute and 5317 New Freedom grant funds are expected to comply with the coordination efforts. Recipients of this funding will commit to these strategies and demonstrate compliance throughout the grant term.

a. Provide information about current coordination activities in the grant applications for Section 5316 and 5317 funds. These activities will be monitored in order to identify local best practices to be included as examples in the update to the Plan.

b. Attend meetings throughout the year and an annual meeting at the end of the grant year with other human services public and private providers to facilitate communication and collaboration. These meetings will be incorporated as much as possible into groups that exist already to avoid duplication of effort. Participants in the meetings will be asked to work actively on elements of the Plan and report on their progress at an annual meeting. Notification about the meeting dates will be sent from the applicant distribution lists. Information will also be posted on the ODOT website at www.odot.org/.

c. Support the development of a resource containing information about public and private agencies that provide transportation services. Agencies will be asked to keep their information up to date in order to maintain current and accurate data for public dissemination.

If you have questions about these strategies at any time during your grant term, please contact ODOT transportation staff at (405) 521-2584 or by email at Klarue@odot.org.

I do hereby agree, on behalf of my organization, that we will actively participate in the above named strategies in compliance with the Coordinated Public Transit - Human Services Transportation Plan for the State of Oklahoma. Our participation will continue throughout the term of the grant.

_________________________________________   _________________________________________
(Printed Name)                 (Title)

_________________________________________   _________________________________________
(Signature)                     (Organization)
**FEDERAL FISCAL YEAR 2009 CERTIFICATIONS AND ASSURANCES FOR FEDERAL TRANSIT ADMINISTRATION ASSISTANCE PROGRAMS**
*(Signature page alternative to providing Certifications and Assurances in TEAM-Web)*

Name of Applicant: ____________________________________________________________

The Applicant agrees to comply with applicable provisions of Categories 01 – 24. _____

OR

The Applicant agrees to comply with applicable provisions of the Categories it has selected:

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>01.</td>
<td>Assurances Required For Each Applicant.</td>
</tr>
<tr>
<td>02.</td>
<td>Lobbying.</td>
</tr>
<tr>
<td>03.</td>
<td>Procurement Compliance.</td>
</tr>
<tr>
<td>04.</td>
<td>Protections for Private Providers of Public Transportation.</td>
</tr>
<tr>
<td>05.</td>
<td>Public Hearing.</td>
</tr>
<tr>
<td>06.</td>
<td>Acquisition of Rolling Stock for Use in Revenue Service.</td>
</tr>
<tr>
<td>07.</td>
<td>Acquisition of Capital Assets by Lease.</td>
</tr>
<tr>
<td>08.</td>
<td>Bus Testing.</td>
</tr>
<tr>
<td>09.</td>
<td>Charter Service Agreement.</td>
</tr>
<tr>
<td>10.</td>
<td>School Transportation Agreement.</td>
</tr>
<tr>
<td>11.</td>
<td>Demand Responsive Service.</td>
</tr>
<tr>
<td>12.</td>
<td>Alcohol Misuse and Prohibited Drug Use.</td>
</tr>
<tr>
<td>13.</td>
<td>Interest and Other Financing Costs.</td>
</tr>
<tr>
<td>15.</td>
<td>Urbanized Area Formula Program.</td>
</tr>
<tr>
<td>16.</td>
<td>Clean Fuels Grant Program.</td>
</tr>
<tr>
<td>17.</td>
<td>Elderly Individuals and Individuals with Disabilities Formula Program and Pilot Program.</td>
</tr>
<tr>
<td>18.</td>
<td>Nonurbanized Area Formula Program for States.</td>
</tr>
<tr>
<td>22.</td>
<td>Tribal Transit Program.</td>
</tr>
<tr>
<td>23.</td>
<td>Infrastructure Finance Projects.</td>
</tr>
</tbody>
</table>
APPENDIX A

FEDERAL FISCAL YEAR 2009 FTA CERTIFICATIONS AND ASSURANCES SIGNATURE PAGE
(Required of all Applicants for FTA assistance and all FTA Grantees with an active capital or formula project)

AFFIRMATION OF APPLICANT

Name of Applicant: _____________________________________________________________________________

Name and Relationship of Authorized Representative: _________________________________________________

BY SIGNING BELOW, on behalf of the Applicant, I declare that the Applicant has duly authorized me to make these certifications and assurances and bind the Applicant's compliance. Thus, the Applicant agrees to comply with all Federal statutes and regulations, and follow applicable Federal directives, and comply with the certifications and assurances as indicated on the foregoing page applicable to each application it makes to the Federal Transit Administration (FTA) in Federal Fiscal Year 2009.

FTA intends that the certifications and assurances the Applicant selects on the other side of this document, as representative of the certifications and assurances in this document, should apply, as provided, to each project for which the Applicant seeks now, or may later, seek FTA assistance during Federal Fiscal Year 2009.

The Applicant affirms the truthfulness and accuracy of the certifications and assurances it has made in the statements submitted herein with this document and any other submission made to FTA, and acknowledges that the Program Fraud Civil Remedies Act of 1986, 31 U.S.C. 3801 et seq., and implementing U.S. DOT regulations, "Program Fraud Civil Remedies," 49 CFR part 31 apply to any certification, assurance or submission made to FTA. The criminal provisions of 18 U.S.C. 1001 apply to any certification, assurance, or submission made in connection with a Federal public transportation program authorized in 49 U.S.C. chapter 53 or any other statute.

In signing this document, I declare under penalties of perjury that the foregoing certifications and assurances, and any other statements made by me on behalf of the Applicant are true and correct.

Signature____________________________________________________________      Date:  _________________

Name_______________________________________________________________

Authorized Representative of Applicant

AFFIRMATION OF APPLICANT'S ATTORNEY

For (Name of Applicant): ________________________________________________________________________

As the undersigned Attorney for the above named Applicant, I hereby affirm to the Applicant that it has authority under State, local, or tribal government law, as applicable, to make and comply with the certifications and assurances as indicated on the foregoing pages. I further affirm that, in my opinion, the certifications and assurances have been legally made and constitute legal and binding obligations on the Applicant.

I further affirm to the Applicant that, to the best of my knowledge, there is no legislation or litigation pending or imminent that might adversely affect the validity of these certifications and assurances, or of the performance of the project.

Signature____________________________________________________________      Date:  _________________

Name_______________________________________________________________

Attorney for Applicant

Each Applicant for FTA financial assistance and each FTA Grantee with an active capital or formula project must provide an Affirmation of Applicant’s Attorney pertaining to the Applicant’s legal capacity. The Applicant may enter its signature in lieu of the Attorney’s signature, provided the Applicant has on file this Affirmation, signed by the attorney and dated this Federal fiscal year.
MATCHING FUNDS COMMITMENT

Directions: Print and complete this form.

Resolved that ______________________________________________________________________

(applicant)

recognized by the state of Oklahoma as a (please choose one)

☐ Private, non-profit organization
☐ State or local governmental authority
☐ Tribal Government
☐ Operator of public transportation services, including private operators of public transportation services

enters into an Agreement with the Oklahoma Department of Transportation to receive

☐ A Federal Transit Administration Section 5316 Job Access and Reverse Commute grant to improve access to transportation services to employment and employment-related activities for welfare recipients and eligible low-income individuals.

☐ A Federal Transit Administration Section 5317 New Freedom grant to expand transportation mobility options to persons with disabilities seeking integration into the work force and full participation in society that go beyond the requirements of the Americans with Disabilities Act of 1990.

Further resolved that ______________________________________________________________________

(applicant)

agrees to provide the required minimum local matching share for Job Access and Reverse Commute or New Freedom projects.

Certification

I hereby certify that the foregoing resolution is a true and correct copy of the resolution presented and adopted by ______________________________________________________________________

(applicant’s governing body)

At a duly authorized meeting held on the ________________ as shown by the minutes of the meeting in my possession.

________________________________________
(Name)

______________________________________            ______________________________________
(Notary)                                            (Title)